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Training Series by Week

Reading and Writing Data

Data Blending and Formatting

Data Preparation

Transforming and Parsing Data

User Interface (Ul), Documentation and Workflow Configuration

Core Certification Exam Preparation

alteryx
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Overview

Processes Covered

— Customizing your palette

— Workflow documentation and design
techniques

— Hot-keys / shortcuts
— Workflow optimization
— User settings

alteryx | o

or Solving
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Customizing the Tool Palette

alteryx
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CUSTOMIZING THE TOOL PALETTE

« Add or Remove Categories

~ Favorited tools from removed categories will remain
(n ‘Favorites

— Tools in removed categories will still appear in
search

« Select which tools are shown in each Category

~ Favorited tools removed from a category will
rematn tn ‘Favorites

— Removed tools will still appear in search

Confidential | ©2021 Alteryx, Inc.

Configure Tool Palette

Preset:

Custom

M n/out

. Preparation
. Join

. Parse

MW Transform

. In-Database
] Reporting

@ Documentation

# spatial

- - ~ ~ d

BI b 2 EY B4 L B

(S

Arrange
Count Records
Cross Tab
Running Total
Summarize
Transpose

Weighted Average

n Ca nce'

alteryx



> ra
YOU'RE MY FAVORITE... OR MAYBE NOT

Hello Text to Columns

Faworites . In/Out . Preparation . Join . Parse

y ®@ D S

- Add or remove tools from your favorites by e ey T
selecting or deselecting the star next to the
tool ... Goodbye Text Input

Favorites [ InvOut @ Preparation [ loin @B P

n o 8 0O @

- Pin your most-used palettes to the left next Towse Tedben Gipabs TRERE g
to your other Favorites
— Right-click on category to pin or unpin W5 fc

Pin Reporting
I_> B Reporting | 4 Favorites [ InvOut @) Preparation

H
3 y = 3 y 3
A ©
Browse Input Data Output Data Data Filter
Cleansing

Confidential | ©2021 Alteryx, Inc. a'l'teryx



SHOW ME THE RESULTS

2= |11 0f 16 Fields |+ % o | Cell Viewer ~| 1 |

B 7] Customer_ID

« Select or deselect fields for viewing in the B oo

results window Order_Priority
Discount

[] Unit_Price

Quantity_ordered_new

CL I VP PP W

4

« View full contents of a cell by Record #
- double-clicking on cell

Customer_ID Order_Priority

— Turning on ‘Cell Viewer’ and selecting cell = 1ofi6Fieds v | CelViewsr - § | T L |-63
. . . . . . Record &3, Field Order_Priority (V_String)
— Click paragraph icon to view/hide whitespace
B
characters
Record # Customer_ID Order_Priority Discou
1 2 Mot Specified 0.01
e 3 Mot Specified 003
| alteryx

Confidential | ©2021 Alteryx, Inc.
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WHERE CAN | SEE THAT?

Results - Workflow - Messages

©ocerors €0 ConvErrors
Designer x64 - Started rum

$ Input Data (11 426 records:
1

summarize 5ales - B426 records

b Join (7] Joins on Doul
W Input Customers: 2678 records

« Click the tool name link to highlight the tool B 00 2678 e

On the Ca nvas E Browse (8) 2093 records

Designer x64 : Finished run

« Click on input or output file links to open
the file

W Input Data {7} 1447 records were read from "C:\Usersh\aglum\DesktopiAlternyy Resources \BootCampldataldatalCA-Pension-Func
“ Join (8) 1447 records were joined with 20 un-joined left records and 0 un-joined right records

u Filter (10} 30 records were True and 1417 were False

E Output Data (127 | : 30 records were written to "C:iUsers\aglum\DesktoplAlteryx Resources\BootCampldatatd ataloutput.my”

alteryx
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BROWSE FOR MORE

Record # Stock Tickers DownloadHeaders < Date Open High Low Close _'lil'nhjme &
- Add a browse to T I —— .
— See at-a-glance which fields contain z
« NOT OK values R N
« NULL values - R U
« EMPTY values :mmw o
« OK values — e
— View a data profile for each field ~
— Open in new window ——
— Copy or save data ;E :
Confidential | ©2021 Alteryx, Inc. aLteryx
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USE YOUR SETTINGS — USER SETTINGS

User Settings

| Defauits | Dataset Defautis | Canvas | Advanced | Macros|
Default Canvas Settings Connection Settings

Background:
White E]

Containers:

« Options > User Settings > Edit User Settings hoo a2 8282 (2]

Show Grid Progress: :
° Canvas Grid Color: " ']
: I
— Background and container defaults y AnncttonSettings
— Grid size and appearance i@ | | R

_ Layo ut Zoom Level: Default - Text Color E] m

Remember last zoom level per workflow

Background:

— Connection style e =

Layout Default: Horizontal -

- A nn Otatl on d efa u Its Display macro indicators on tools m'\DesktophAlteryx Resources\h

miDesktoplAlteryx Resources',

Set as Default

© @

m'\DesktopiAlteryx Starter Kit fg

i Macros [ oK H T H Apply H Help ]
— Add new tool category to your palette for Macros e Seareh Path for Macros

Category Name: My Mew Categary!

Search Path: C:hUsersaglum®Desktop \Alteryx Resources'\Macros E

Confidential | ©2021 Alteryx, Inc.




Moving In Designer

alteryx
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HOT KEYS

Press this key combo

CTRL+R Run workflow

CTRL+SHIFT+ "+’ Align Vertically

CTRL+SHIFT+ "~ Align Horizontally
CTRL+SHIFT+B Add all browses

CTRL+0 (Zero) Zoom to highlighted selection
CTRL+F Find tool within workflow

F1 Open help page for selected tool

alteryx
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FILE TYPES

File Type File Extension

.yxmd

Workflows
Macros

Apps

Database

File Types
Zipped Package

Confidential | ©2021 Alteryx, Inc.

.yxmc
YXWZ
yxdb
yxft

YXzp

(S

alteryx



RIGHT-CLICK ON A TOOL

« Delete/Cut and connect around

« Zoom

« Add to New Container

« Bring to Front/Back

« Make connections wireless / wired
« Cache and Run Workflow

« Insert (Tool) After

« Add browse after

— If multiple outputs, you can add browses after all or
a spectfic output

Confidential | ©2021 Alteryx, Inc.

ges [E

Cut Ctrl+X
Copy Ctrl+C
Delete Delete

Cut and Connect Around  Shift+ Ctrl+ X
Delete and Connect &round  Shift+Del

Zoom

Yiew Possible Connections

Add To Mew Container
Bring to Front
Send ta Back

Make Incoming Connections Wireless

Make Qutgoing Connections Wireless
Cache and Run Worlkflow

Insert After
Add Browse After Ctrl+5Shift+B

Properties

alteryx



RIGHT-CLICK ON A CONNECTION

Switch origin to
— If multiple output options from origin tool

Switch destination to
— If multiple input options for destination tool

Delete connection
Make connection wireless/ wired

Insert (tool) in connection

Confidential | ©2021 Alteryx, Inc.

L@ﬁ

(S

Zoom

Switch ongin to
Switch destination to
Delete Connection

Make Connection Wireless

Insert in Connection

alteryx



RIGHT-CLICK ON SELECTION

- Add to New Container

« Make Incoming Connections Wireless
« Make Outgoing Connections Wireless
« Align Horizontally

« Align Vertically

Confidential | ©2021 Alteryx, Inc.

a¥T I
Cut

Copy
Delete

Zoom

Add To Mew Container
Bring to Front
Send to Back

Make Incoming Connections Wireless

Make Outgoing Connections Wireless

Align Horizontally
Align Vertically

alteryx



RIGHT-CLICK ON CANVAS

« Zoom
— In, Normal or Out — N S
- A” o ) Insert » Zoom Mormal
- To speC|f|c container _ Zoom Out
Find Tool...
 Insert All
— Tool Selected tools
- Macro Container 4
« Find Tool
— Navigate to specific tool on canvas
Confidential | ©2021 Alteryx, Inc. aLteryX
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Workflow Design

Documentation techniques to keep you organized

Confidential | ©2021 Alteryx, Inc.
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CONTAIN IT

i PrepandBlend (=f 1l m

« Organize your workflow into logical groups Tool Container (4) - Configuration - B X
. . . Caption n]
« Name each container to you can easily find (PP and Bend ’
it later @

. . . . Text Color R=49, G=76, B=74
— Hint: Right-click and zoom to container o

Fill Color R=236, G=242 B=242 E]
. . . . Border Color  [RE-kREEi Y]
« Collapse for easier viewing and arranging of = .
your workflow vogn (5 5
- Disable containers to prevent its contents _
from running
Confidential | ©2021 Alteryx, Inc. a'l'teryx
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TAKE A NOTE OF THAT: TOOL ANNOTATIONS

« Click the Annotation icon in the left-side Join & -Ansotatio
nav of configuration window

>
04 . \.#}
- Enter a custom tool name to easily navigate \E My Favore o

to the desired tool and identify results @ s serctcion
Annctation [T¥8S J€iing -
messages [] Place Annotation on the Top
. Annctation
° Add an annotatlon to document eaCh Step Erining together data from multiple sources

in the process

Confidential | ©2021 Alteryx, Inc. alteryx



TAKE A NOTE OF THAT: COMMENT TOOL

« Add comment tools to include images and [

Zip Code Analysis
Amelia Glum

text on the canvas

« TIP! Add multiple comment tools to a tool

(S

m D—Eg D—Eg ]—E@?"““-{I D—EID

Unique:
COMAME, ADDR

CsSVGeocode_exa
mple.csv

FIP=PadLeft
([ZIP], 5. 07

Bxpand Container to View Workflow Documentation

container to easily collapse and expand
workflow documentation

Confidential | ©2021 Alteryx, Inc.

®
The Unigue The Formula tool is :
Use the Input The zl?cthocl The Record ID tool is used to used to re-format ELT iiuumsg'.;;ze
tool to read in ';er;ct o e tool is used to filter out the ZIP Code field. ohtain 2 count of
SV file. 8551gN & unigue duplicate Leading zeros are how many
Lnnecessary ID field to each records inour | R R | e the
iyl r=cord datafle kL LI | same ZIP Code
1=lds ar;_ LT less than & ’
name 2 held. characters.
alteryx




» ra

TAKE A NOTE OF THAT: EXPRESSION BOX COMMENTS

Add comments within an Expression box R

— Use //Comment for a single line 5 {;[I:PutCDlumn i I .
: . L1}
— Use /* Comments */ for multiple lines e Ml ProLEFT((ZP1, 5, o)
v

LY //add leading zero to [ZIP]

@ [®] /*ndd multiple lines
of comments */

Data type: | V_String * | Size: | 254

alteryx
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THAT'S SO META —

| canvas | workflow | Runtime | Events | MetaInfo | xmL view|

o Waorkflow Name

() Use File Mame

@ Custom:  Zip Code Analysis
Description

Find total cusotmers by zip code|

« Name

— Add a custom name or the workflow file name will
be used by default

Display Text [optionall | |

ool Settings

oot Tool Name: | |

T
R
Tool Versiomn: | |
T

« Description

ool In-Database? |:|

Tool Palette

Category Mame: ‘

Search Tags:

« Author

— TIP: You can set your defaults in the Author box so
you don't have to type in your information every

.
time Set 1o Deta

_ Autner

Name: Amelia Glum

Company:  Alteryx

alteryx
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Workflow Design
But wait...there's more

alteryx
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Workflow - Configuration -~ QX m

EV E N TS | canvas | werkflow | Runtime | Events | Meta Info | XML View |

@ | [ enable Events
Ewents:
| Addv
|_ Run Command...
| Send Email...
Evert | Asset(s) |LI
[ pown |
« Trigger an Event when Run Event When: |8 .
N @ Autodetect SMTI After Fun
— Disabled ® UseSMTPSemrggb%d:mﬂmEfm
— After run
To:
- After run Wlth errors Subject: SehAppMamet: ScModule: - 2NumErrors®: Errors
— After run without errors et
(€]
« Run Command
. Body: User: S:User3
+ Send Email st
— Add Attachments Warnings: sWaringst
— Output log included in body R
[ ok || canced || Help
alteryx
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Workflow - Configuration -1

Canvas | Workflow | Runtime | Events | Meta Info | XML view|

GO GLOBAL °

@ Standard Workflow
) Analytic App

) Macra: Standard Macro -

Caonstants:

« Add global variables (user constants) in your

Type MName Value

WO rk.ﬂ OW Setti n g S Engine | TempFilePath Citemp

[l
Engine |Version 11.0.5.26351 |:|
1. Click the @ to add a new variable e =
. . .. User MyGlobalVariable |10 [l
2. Check the box in the # column if this is a PR vser | spccaivariabie  [RE <

numeric value

Formula (1) - Configuration

Output Column Data Preview
- .

~  New Field € Empty expression

« Global variables can be used throughout the 0
workflow and will be found under Constants o

E “w Existing Columns

9 =
« You can reference them using the syntax

s Constants

[User.MyGlobalVariable]

EngineVersion

Color

Engine.WaorkflowDirectory
Engine.Guilnteraction
User.MyGlobalVariable
User.SpecialVariable

Confidential | ©2021 Alteryx, Inc.



PACK IT UP

« Easily share workflows and their
dependencies

 Include in the workflow package
— Datasets

— Custom Macros

 Only include macros which the receiving user does
not have i.e. you do not have to include the Data
Cleansing macro as this tool comes standard with
Designer

Confidential | ©2021 Alteryx, Inc.
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Options Help
o Bun Workflow

(‘3 Schedule Worlflow

Yiew Schedules

Run Analytic Apps

Export Workflow

Activate License Key

Manage Licenses

User Settings

Advanced Options

Export Settings

Workflow Joining_Data_.Join_Tool yxmd m

Package Location C:\Program Files\Alteryx\bin\..\Samples\eni0Z

Group assets by tool Undo changes

CAProgram Files\Alteny\bin\RuntimeDatal\Macros\Cleanse.yxmc
v MA\SampleData\C5VGeocode_example.csv
v (QUTPUT) output.csv

v M\SampleData\Sample_ZIP.yxdb

Cancel Help



v
N

Options Help

IT'S ALL RELATIVE Oavittn x| varce v comcirs

egchedule Worldlaw Manage In-DB Connections

View Schedules Workflow Dependencies

i Encrypt Workflow
Run Analytic Apps )
- All Absolute oot System Settings
— changes all file dependencies to an absolute Adtvate License Key
path to the flle location Manage Licenses
User Seftings >

° Al | Re I ative Workflow Dependencies Advanced Options >

Show Individual Tools

— changes all file dependencies to a relative path it | tombon | Dependency
to th e WO rkfl OW | Oca t i O n 2 ChUsers‘aglum\Desktop\Alteryx Resources\My Exercises\Sample Workflow

« Al UNC

— changes all file dependencies to a Uniform
Naming Convention; all mapped drives are
renamed to a network resource

Waorkflow Path: C\Program Files\Alteny\bin

Al UNC || Test || 21l Absolute || All Relative | | oK || Cancel || Help |

dLLeryx

Confidential | ©2021 Alteryx, Inc.



Workflow Optimization

alteryx
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FASTER IS BETTER

Workflow - Configuration * 1 X

° lelt records frOm a” inputs Canvas | Workflow | Runtime | Events | Meta Info | XML view|

e Dedicated Sort/Join Memory Usage
@ Use Global Default

« Automatically stop running the workflow when © Use Specitc Amourt. 1088 ] wegabyes
there is an error

Tempaorary files
@ Use Global Default

+ Disable all Browse Tools R
° 1 1 Conversion Errors
Show all macro messages for easier debugging oenenerer

ry

Maximum Errors per Location: |10

-

« Disable all tools that write output 1) Stap Prcessing Wnen Limit = R

Record Limit for All Inputs: Mo Limit

- Enable performance profiling to aid in - |
. . Cancel Running Workflow on Errar
troubleshooting and understand the processing ) Dsable i Erovse Too's
time and usage associated with each tool ) Show Al Macro Messages

|:| Disable All Tools that Write Output

|:| Enable Performance Profiling

alteryx
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LEAN FOR SPEED

Only use the data you need

Use Visual Query Builder or SQL Editor to limit records and fields read in from databases

Use Select tool to remove columns
— Join, Join Multiple, Spatial Match, Find Nearest also have select functionality

Use the Filter tool to remove rows

Use the Auto Field tool to assign most efficient data type and size
— BONUS: Reduce the size of your output file!

alteryx



DATABASE CONNECTIONS

° DO Not ShOW % Complete Input Data (1) - Configuration * 0 %
Connect a File or Database
. odb:Provider=5QLOLEDE. 1:Integrated Security=55PLPersist Security Info=False:Initial Catalog=Demo DE; B
L . <[>
For faster workflow development ==
— Cache Data Q | Mame Value
1 Record Limit
— Record Limit (Input tool or Runtime settings) O e o (0leDb Database (odb) -]
3 Table or Query dbo."Customers” E]
o * . . ‘4 Cache Data
Remember to use Visual Query Builder or 5 ToieFckdvone 51 i (B .
SQL editor to remove unneeded data 6 Read Uncommited 0
m— 7 [ ot Show % Complete
& Pre Create SQL Statement [:]
9 Post Create SQL Statement E]
Confidential | ©2021 Alteryx, Inc. a'l'teryx



Tool Specific Tricks

Did you know you could do that?

alteryx
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» ra
SELECT TOOL

- Add Prefix/Suffix = A =

Options - | L TIP: To recrder multiple rows: select, right-click and drag.
. . <[> SR ' Size  Rename Description
« Remove Prefix Suffix g ==
5 Change Field Type of Highlighted Fields » 755
. . Sort 3
— *Make sure to select the fields you'd like to 2 g =
modify before opening up the Options menu A Prcin o Fild Nomes 2
Add Suffix to Field Names 755
Remove Prefix Remove "T" from Highlighted Field Names
® C | Al | R Remove Suffix Remaove "Tr" from Highlighted Field Names
ea r e n a m eS Clear All Renames Remove "Tra" from Highlighted Field Names
Clear Highlighted Renames Remove "Tran" from Highlighted Field Names
° FO r et Al | M iSSi n F i e | d S Revert Al.l to .Original T}‘F’-E .&'- Size . Remove "Trans" from Highlighted Field Names
g g Revert Highlighted to Original Type & Size Remove "Transa" from Highlighted Field Names
Forget All Missing Fields Remove "Transac" from Highlighted Field Mames
Forget Highlighted Missing Fields Remove “Transact” from Highlighted Field Names
Transaction_Dizcourt V_String Remove "Transacti" from Highlighted Field Names
Transaction_Unit_Price V_String Remove "Transactio” from Highlighted Field Names
Transaction_Quantity_ordered_new | V_String Remove "Transaction” from Highlighted Field Mames
Transaction_Order_Date V_String Remove "Transaction_" from Highlighted Field Names
T

alteryx
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SELECT TOOL (CONT.)

- Save field configuration determined by
Auto-field tool or manually set in the Select
tool for later use

1. (Optional) Run workflow with Auto-field
tool for optimal data type and size

Save Field Configuration

Save .yxft file

(Optional) Remove Auto-field tool
Load Field Names & Types

oA~ W

Confidential | ©2021 Alteryx, Inc.

CA-Pension- __-|Auto Field (15) i

Funding-Data.csv

TIP: To reorder multiple rows: select, nght-chck and drag.

Save/Load Save Field Configuration

Select Load Field Mames

Change Field Type of Highlighted Fields Load Field Names & Types

File name: | tool_specific_config.yxft]

Save as type: | Designer x64 Field Type Files (*.yxft)

TIP: To reorder multiple rows: select, right-click and drag.

Save/Load Save Field Configuration

Select Load Field Mames
Change Field Type of Highlighted Fields Load Field Mames & Types

atrteryx



JOIN TOOL

Join (3) - Configuration 1

() Join by Record Position

L[> (@) Join by Specific Fields

« All Select Tool functionality plus the ability

@ Left Right @
to ‘Deselect Duplicate Fields'! o |\ [ jeelceenen -
. 9 * ETY w
o@D >(Q) =P
Options - | T 1 TIP: Te reorder multiple rows: select, right-click and drag.
forlis g Size  Rename Description ~
- g1
Change Field Type of Highlighted Fields 255
il Y Flass
Move Y b s
Add Prefix to Field Mames 255
Add Suffix to Field Names 255
Remowve Prefix 255
Remowe Suffix a
Clear All Renarmes 255
Clear Highlighted Renames 255
Revert All to Original Type & Size 255
Revert Highlighted to Criginal Type & Size 4
Forget All Missing Fields 254
Forget Highlighted Missing Fields 254

Confidential | ©2021 Alteryx, Inc. a'l'teryx



Finding the Resource

oo o
oo o o o *
Moo o o o °
oo o o0 0 o

o CICN SRR

alteryx
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A BETTER WAY TO SEARCH

Quickly search for related
— Tools
« Designer
« Alteryx Gallery
« Your Company's Gallery (If Available)
— Help documentation
— Community Articles

« Knowledgebase, Discussions, and more
« Submit your question if you can't find the answer!

Confidential | ©2021 Alteryx, Inc.

ra

Q, pivotf

]

Tools

B .
>> Cross Tab Example

” Transpose Help

>= Table

Pivotal Greenplum
Pivotal Greenplum  Alteryx tools used to connect: Input Data and

ey Output Data (Standard workflow processing..
»WEL: Transpose In-DB

PivotStyleMethods

Alteryx Gallery results > Table Tool

The Table tool allows the user to create basic data tables and pivot tables

My Company's Gallery results » from their input data. TIP: To include a header or footer to..

Cross Tab Tool
The Cross Tab tool pivots the orientation of data in a table by moving
vertical data fields onto a horizontal axis and summarizing data...

Community Transpose Tool
The Transpose tool allows you to pivot the crientation of the data table,
Transform and pivot It transforms the data so you may view Horizontal data fields..,

['would like to take the before sprea
guessing Transform and Cross Tabw View more Help results

Raw data to Pivot table
Hi everyone, [ am trying to change the following data into a pivot table, [
am totally lost on how to do this. Any ideas? [ have attached...

Pivoting the data
Hi, I've a dataset that looks like this(demo only, I've more columns in it)
Title Mr Mrs Name John Alice Surname Adams Adams Address 3z...

Table Tool - Crosstab,/Pivot Formatting
Hi all, I have been attempting to utilize conditional row/column/data
farmatting available in the Table tool, however it does not appear to..

Pivotal Greenplum - Connect In-DB
Hi, I'm looking to use the In-Datablase tools with a Greenplum
Datasource. According to the Alteryx help docs, it's supported...

View more Community results  »

alteryx

Ask the Community a question



WHAT'S THIS DO? TOOL FUNCTIONALITY

Left-click on tool in palette for description

Click on ‘Open Example’ link in description
for a sample workflow specific to the tool

— *Not all tools have a sample workflow specific to the
tool, but you may find sample workflows containing the
tool in Help>Sample Workflows

Click on the '?" icon in Configuration
window togo directly to the help page for
the selected tool

Confidential | ©2021 Alteryx, Inc.

B O

fput Data  Text Input Data

ra

¥
© & O
H
Filter Formula
Cleansing

Data Cleansing

Perform basic data cleansing
operations such as replacing null
walues, removing punctuation, and
modifying capitalization.

)  Cpen Example

Data Cleansing (1) - Configuration

Cptions

<>

P
(M

?
) |

Select Fields to Cleanse

W Csome 0 |
[[] order_ID

[] order_Priority

[ Discount

[] Unit_Price

Quantity_ordered_new

Order_Date

alteryx



MACROS FOR EVEN MORE

« Crew Macro Pack (Chaos Reigns Within)
— www.chaosreignswithin.com

— New macros added quarterly
— Find through community search
— Ex: Moving Summarize, Skip Last N, etc

« Public Gallery

— https://gallery.alteryx.com

— Macros District

— Search for useful macros created by our Alteryx
community of users!

Confidential | ©2021 Alteryx, Inc.

teveloper  J laboratory g Tableau

7 P R
5 JS0ON Maving Trim Mean
Create Summarize

alteryx | giilt

Districts > Macro District

Macro District

DISTRICTS

PRIVATE
STUDIO

STUDIOS
even better.

-
COLLECTIONS

Advanced Join

@ Alteryx Products
A Analytic App

ra

@ CReW Macros g CReW Test

3 » > 3 » Al

[ [
Weighted Bivariate Gauge
Median Theming

Alteryx is the leader in self-service data analytics. Alteryx Analytics provides analysts the unigue
for deeper insights in hours, not weeks. Analysts love the Alteryx Analytics platform because they
data together, then perform analytics - predictive, statistical, and spatial - using the same intuitiv

Take a look at the included macros to include in your Alteryx Designer experience. The included
applications to put them to work for your business!

Do you have a macro to share? To add your macro to the Macro District, save your macro in a wo
description and then Publish it to the Gallery. Make sure the option to Download is selected so o

Allocate Rename Fields

@ Alteryx Products
a A nalytic App

BB Date

@ JP Kabler
M Macro

Cache Dataset

@ Alteryx Products
M Macro

alteryx


http://www.chaosreignswithin.com/
https://gallery.alteryx.com/

User Interface (Ul), Documentation and
Workflow Configuration: Alteryx Designer
Training

alteryx
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alteryx

Thank you

alteryx.com




